
ภาคผนวก ก
การไดมาซึ่งขอมูลสารสนเทศภูมิศาสตร

การไดมาของขอมูลสารสนเทศภูมิศาสตร ซึ่งประกอบดวย
ขอมูลชนิดภาพ (Raster) ซึ่งเปนขอมูลจากภาพถายทางอากาศ
ขอมูลชนิดเวกเตอร (Vector) ซึ่งเปนขอมูลลายเสน เชน เสน (PolyLine) พื้นที่รูปปด 
(Polygon) และ จุด (Point)
1. ขอมูลภาพ (Raster) เปนขอมูลภาพถายทางอากาศบริเวณเขต เทศบาลนครเชียงใหม 

ถายเมื่อเดือนพฤศจิกายน พุทธศักราช 2543 นํามาจากภาพถายจุด ผังเมืองจังหวัด
เชียงใหม ขนาดภาพละ 4 ตารางกิโลเมตร ในรูปแบบของไฟลชนิด JPEG แลวมาทํา
การกําหนดคาพิกัดบนภาพถาย (Image Registration) โดยวิธี Rubber Sheet 
Registration โดยใชโปรแกรม AutoCADMap จุดควบคุมภาพใชวิธีการวัดตําแหนง
บนผิวโลกจาก Land Mark ที่เห็นบนภาพ โดยใชเคร่ืองรับสัญญาณดาวเทียมชนิด 
GPS. ระบบพิกัดที่ใชในการควบคุมภาพ เปนระบบพิกัดภูมิศาสตร (Geographic 
Coordinate System) และใชศูนยกําเหนิด (Datum) เปน Indian 1975

รูปที่ 1 ภาพถายทางอากาศเมื่อไดรับการปรับคาพิกัดแลว
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ใน AutoCAD Map ตองกําหนดระบบพิกัดใหสอดคลองระบบพิกัดที่ตองการ ซึ่งสามารถกําหนดได
ดังนี้ ใน AutoCAD Map Menu MAP � Assign Global Coordinate System จะปรากฏดังภาพ

รูปที่ 2 Thailand west of 102d East; Indian 1975 Datum
ใหระบุ Coordinate System และ Datum เปน THAI-W75ใชในการทํางานครั้งนี้

เนื่องดวยภาพถายทางอากาศที่นําเขามาใชในคร้ังนี้มีขนาดไฟลคอนขางใหญมากรวม 700 MB เพื่อ
ทําใหการประมวลภาพถายทางอากาศแตละคร้ังของเซิฟเวอรไมทํางานหนักมากเกินไป กอนสงขอ
มูลที่ไดกลับไปยังผูเรียกใช (Client) จึงจําเปนตองทําภาพที่มีขนาดใหญซอยยอยลงมาเปนแผนๆ
เล็กๆเพื่อความเร็วในการประมวลภาพถายแตละคร้ังของ เซิฟเวอรกอนสงไปยังผูเรียกใช โดยใช
โปรแกรม Image Ready โดยการเปดภาพที่ตองการซอยยอยแลวเรียกใชคําสั่ง Select -> Select All
จากนั้นเรียกใชคําสั่ง Slice -> Slice จากนั้นระบุจํานวนภาพที่จะซอยยอยในแนวตั้งและแนวนอน
เพื่อทําการเชฟออกมาเปนไฟลยอยๆดวยคําสั่ง save Optimized
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รูปที่ 3 ลักษณะภาพถายทางอากาศที่ถูกแบงออกเปนแผนยอยๆ

รูปที่ 4 การแบงภาพเปนแผนยอยๆ จํานวน 10x10 ภาพ
แลวเพื่อลดขนาดของภาพลงเมื่อไดภาพถายทางอากาศที่ไดจากการหั่นเปนแผนยอยๆแลวจากนั้นก็
นํ้าภาพถายทางอากาศดังกลาวเขาสู AutoCAD Map
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การจัดวางตําแหนงพิกัดใหถูกตองโดยใชคําสั่ง Insert � Raster Image เมื่อนําภาพถายทางอากาศ
เขาสู AutoCAD Map ครบแลวก็ทําการ Export World Files ซึ่งเปนไฟลที่ระบุคุณสมบัติของภาพ
ถายแตภาพใหสอดคลองกับพิกัดโลกในการอางอิง

                                      รูปที่ 5 การสงออกขอมูลพิกัดของภาพถายทางอากาศ
2. ขอมูล เวคเตอร (Vector) ไดมาจากสองสวนหลักๆคือ

1.1.1 ระบุในแผนที่ ที่ไดรับปรับแตงพิกัดภาพถายทางอากาศใหตรงกับพิกัด
โลกแลวขอมูลดังกลาว เชน ตําแหนงอาคาร ขอบเขตพื้นที่ของแขวงตางๆ เปนตนขอมูลที่
ไดจากการบันทึกเสนทางโดยใช อุปกรณนํารองดาวเทียม (GPS) ในการจัดทําเสนทางโดย
ตรง โดยมีวิธีการดังนี้นําปาลม เชื่อมตอกับ อุปกรณนํารองดาวเทียม (GPS) โดยใช
โปรแกรม Cetus เพื่อบันทึกเสนทาง (Tracking)

1.1.2      อุปกรณระบุตําแหนงดวยดาวเทียมถือวาเปนหัวใจหลักในการบันทึกเสนทางภาพ
ที่เห็นอุปกรณกําลังหาตําแหนงดาวเทียมเพื่ออางอิงพิกัดที่อยูปจจุบันซึ่งตองใชดาวเทียมต้ัง
แต 3 ดวงขึ้นไปเพื่อระบุตําแหนงตัวเองได ชวงเวลาที่ตําแหนงดาวเทียมเหมาะสมจะเปน
ชวงที่รับสัญญานดาวเทียมไดดีที่สุดซึ่งจะใหคาผิดพลาดนอย จึงมีความแมนยําสูงในการ
บันทึกเสนทางตางๆ (ภาพ GPS กําลังหาสัญญาณดาวเทียม)
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รูปที่ 6  อุปกรณระบุตําแหนงดวยดาวเทียมและปาลม

อีกสวนหนึ่งที่มีความสําคัญอุปกรณบันทึกขอมูลในที่นี้ใชปาลม หนาที่ปาลมคือบันทึกขอมูลซึ่งได
รับจาก GPS ลงสูหนวยความจําลักษณะขอมูลที่ไดจะเปน Latitude และ Longtitude โดยต้ังชื่อเสน
ทางที่จะทําเสนทาง และระยะเวลาที่จะใหบันทึกเสนทาง เชน ชื่อ Setup ใหบันทึกทุกๆ 5 วินาที ซึ่ง
สามารถเปลี่ยนแปลงความเร็วในการบันทึกไดตามความเหมาะสมวาควรจะอยูในชวงใด 1 2 5 10 
หรือ 30 วินาที (ดังรูปที่ 5) ขอควรระวัง ควรใหแนใจวาโปรแกรมจัดทําบันทึกเสนทางไดรับ
สัญญานจาก GPS แลวจึงทําการบันทึกเสนทาง

วิธีการเซ็ตคา GPS ใหสงสัญญานออกไปยังโปรแกรมจัดทําบันทึกเสนทางกระทําไดดังนี้ 
ในที่นี้จะอางอิงถีง GPS Garmin รุน Etrex เทานั้น แตอยางไรก็ดีสามารถปรับใชกับ GPS ทุกรุนที่
สามารถปลอยสัญญาณGPS ที่เปน NMEA Standard (National Marine Electronics Association) 
ออกมาได ทั้งนี้ความละเอียดของขอมูลขึ้นอยูกับคุณภาพของ GPS แตละชนิด การเซต GPS ให
ความสําคัญอยูสองสวนหลักคือ สวน Units และ Interface สวน Units ใหเลือกใช LAT/LON หรือ 
hdd.dddd องศาใช DATUM Indian 1975 หนวยเปน METRIC และ North Reference เปน True 
สวน Interface ใหเลือก NMEA OUT และ Baud Rate 4800 BPS ซึ่งเปนความเร็วใน  การโอนถาย
ขอมูล ระหวาง GPS และ ปาลม

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d



62

รูปที่ 7 ภาพหนาจอหลักในการเซ็ตอัพ
เมื่อไดขอมูลการบันทึกเสนทางดวย GPS แลวจากนั้นนําขอมูลที่บันทึกเสนทางไดโอนเขาสูวินโดว
ผานทางสายเชื่อมตอของปาลม และทําการเปลี่ยนขอมูลที่อยูในรูปแบบของปาลมเปนรูปแบบ Text
file บนวินโดวโดยใช โปรแกรม Tracklog ซึ่งมีวิธีการทําดังภาพ

                                                      รูปที่ 8 การใชงาน TrackLog

นําไฟลดังการไปตัดสวนตางๆออกดวยโปรแกรม EXCEL แลวใหเหลือรูปแบบรูปแบบ
Latitude และ Longtitude ดังภาพ
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รูปที่ 9 Text File ซึ่งเปดดวย Excel

รูปที่ 10 ลักษณะไฟลที่พรอมสําหรับการสรางเสนทางใน AutoCAD Map
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จากนั้นเปดโปรแกรม AutoCAD Map เพื่อทําการนําขอมูลที่เก็บมาเพื่อทําการใหโปรแกรมสราง
เสนทาง โดยใชโปรแกรมชวย Dpoint.lsp (AutoLISP) เพื่อสั่งใหระบบทําการวาดเสนจากขอมูลที่
ไดเก็บมา รูปแบบไฟล Dpoint.lsp มีลักษณะดังนี้
เร่ิมตนไฟล ---� defun draw-point (name / fd rl)

    (setq fd (open name "r"))
   (command "pline")
   (while (setq rl (read-line fd))
      (command (princ rl))
    )
    (command "")
    (close fd)
)
(defun C:DPOINT ( / name)
    (setq name (getstring "\nFile name: "))
    (draw-point name)
    (princ)
)<---- สิ้นสุดไฟล ---------------

การทําใหโหลด Utility Dpoint.lsp เขาสู AutoCAD Map ทําไดโดยคําสั่ง “Load (Dpoint)” ซึ่งไฟล
Dpoint.lsp ตองอยูใน Support Directory ของ AutoCAD Map มิฉะนั้นจะไมสามารถโหลดใชงาน
ได เมื่อโหลดเสร็จก็สามารถเรียกใชคําสั่ง Dpoint แลวระบุไฟลที่จัดเตรียมไว เพื่อสั่งใหโปรแกรม
เขียนเสนทางตามไฟลที่ตองการ เปนอันสิ้นสุด (ดังภาพ)

รูปที่ 11 การใชคําสั่ง Dpoint ในการสรางเสนทาง
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รูปที่ 12 เสนทางเมื่อใชคําสั่ง Dpoint เสร็จสิ้นจะปรากฏดังภาพ
เนื่องจากเสนทางที่บันทึกดวย GPS ถูกบันทึกลงดวยขอมูล Latitude / Longtitude จึงมีความจําเปน
ตองเซ็ตพิกัดโลกใน AutoCAD Map ใหสัมพันธกับระบบพิกัดที่ไดรับมา โดยการใชคําสั่ง Map

-> Tools -> Assign Map Coordinate System ดังภาพ

รูปที่ 13 กําหนด Coordinate System Projection เปน THAI-W75
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จะสังเกตไดวา ระบบจะใชวิธีระบุ Coordinate System Projection ที่ใชมีอยูในการคนควาแบบอิสระ
คร้ังนี้มีอยูดวยกัน 2 Coordinate System คือ WGS84 Latitude / Longtitude,Degrees และ Thailand 
west of 102d East; Indian 1975 Datum รูปแบบ WGS84 Latitude / Longtitude,Degrees นั้นกําหนด
ใชเมื่อนําพิกัดที่ทําการบันทึกเสนทางมาใชใน AutoCAD Map เทานั้น แตการระบุแบบ และ 
Thailand west of 102d East; Indian 1975 ใชในการทํางานทั่วไปๆใน AutoCAD Map เนื่องจากวิธี
การระบุตําแหนงใน AutoCAD Map ระบุแบบพิกัดแนวตั้งแนวนอน (X and Y Coordinate System)
ซึ่งทําใหสะดวกในการทาํงานมากกวากาํหนดแบบอื่นๆการโอนถายขอมูลระหวาง Coordinate 
System โปรแกรมจะทําการแปลงใหอัตโนมัติ ซึ่งทําใหมีความสะดวกตอการทํางานเมื่อไดจัด
เตรียมขอมูลทั้งภาพถายทางอากาศที่ทําการซอยยอยเปนแผนๆและขอมูลเสนทางซึ่งจัดทําดวย GPS 
เสร็จสิ้นแลวการนําขอมูลทั้ง 2 ประเภทมารวมกันจัดทําไดโดยสรางไฟลซึ่งมีระบบ Coordinate 
System เปนแบบ Thailand Indian 1975 Datum จากนั้นใชคําสั่ง Insert External Reference เพื่อทํา
การนําเขาภาพเสนทางซึ่งจัดทําดวย GPS เขาสูระบบพิกัดใหมซึ่งจัดเตรียมไวแลว ระบบ 
Coordinate System จะทําการแปลงอัตโนมัติ

รูปที่ 14 หลักการทํา Rubber Sheet
หลักการคือยืดหรือหด จากจุดนั้นเขาไปยัง จุดที่อางอิง ซึ่งบางกรณีเรียกวิธีการแบบนี้วา
Registeration
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จาก WGS84 Datum Latitude / Longtitude,Degrees เปนระบบที่เซตไวในไฟลที่ใชงานอยูปจจุบัน
คือ Thailand west of 102d East; Indian 1975 สาเหตุที่ใชระบบ Coordinate เพราะเปนที่นิยมทั่วไป
เมื่อนําเขาขอมูลทั้งสองประเภทเขามาในไฟลแลวจากนั้นทําการปรับภาพถายทางอากาศใหเขาสู
พิกัดจริงของโลกซึ่งในที่นี้อางอิงกับเสนทางซึ่งบันทึกเสนทางโดยใชดาวเทียมนํารอง (GPS) โดย
ทําการทําจุดอางอิงแลวปรับเขาสูตําแหนงที่ถูกตองซึ่งเทคนิดนี้เรียกวา Rubber Sheet

รูปที่ 15 การเรียกใชคําสั่ง Rubber Sheet
ในกรณีนี้ ขอมูลภาพถายทางอากาศของเทศบาลเมืองเชียงใหม ถูกอางอิงกับสี่แยกหลักๆ ของวง
แหวนรอบนอกของตัวเมืองเชียงใหม อาทิ สี่แยกรินคํา สี่แยกขวงสิงห สี่แยกดอยสเก็ด สี่แยกสัน
กําแพง สี่แยกดอนจั่น และสี่แยกสนามบิน กลาวคือพยายามหาจุดอางอิงใหครอบคลุมพื้นที่ภาพถาย
ทางอากาศใหใกลเคียงความเปนจริงมากที่สุดเทาที่จะเปนไปได

การสงขอมูลออกสู MapGuide Server
การสงขอมูลออกมีอยู 2 ประเภทคือขอมูล Vector และ ขอมูล Raster ขอมูล Vector 

ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไปยังเซิฟเวอรนั้นตองทําการ
ระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และระบุพิกัดโลกที่จะสงออกให
ถูกตองดวย วิธีการคือ เลือก Menu Map ->Tools -> Export to Autodesk Mapguide ขอมูล Vector 
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ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไปยังเซิฟเวอรนั้นตองทําการ
ระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และระบุพิกัดโลกที่จะสงออกให
ถูกตองดวย วิธีการคือ เลือก

1. ขอมูล Vector ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไป
ยังเซิฟเวอรนั้นตองทําการระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และ
ระบุพิกัดโลกที่จะสงออกใหถูกตองดวย วิธีการคือ เลือก Menu Map ->Tools -> Export to
Autodesk Mapguide

รูปที่ 16 การสงออกขอมูล Spatial Data File (SDF)
ในการสงขอมูลออกนั้นสามารถเลือก ขอมูลที่จะสงออกไดโดยการเลือกเองหรือโดยการ
ใหโปรแกรมเลือกแบบอัตโนมัติได นอกจากนี้ยังสามารถเลือกแบบกําหนดชั้น (Layer) 
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ของไฟลนั้นๆไดดวย เพื่อใหแนใจวาขอมูลที่สงออกเปนขอมูลที่ตองการ สามารถดูจาก 
Preview Filtered Object กอนสงออกไฟล Spatial Data File (SDF) อีกสวนหนึ่งที่จําเปน
ตองระบุคือระบบพิกัดที่ตองการจะสงออกวากําหนดใหเปนระบบพิกัดใดใหสอดคลองกับ
ระบบพิกัดบนเซิฟเวอรที่จัดทําในที่นี้ระบุเปนระบบพิกัดแบบ Thailand west of 102d East; 
Indian 1975 ในการสงออก

รูปที่ 17 เปนการกําหนดคุณสมบัติของไฟล SDF ที่ตองการสงออก
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นอกจากนี้กรณีที่ขอมูลที่ตองการสงออกมีฐานขอมูลเชื่อมตออยูก็สามารถสงรูปแบบของ Spatial 
Data File ในลักษณะที่มีขอมูลเชื่อมติดไปดวยไดเชนกันซึ่งจะเห็นไดในสวน Data Expression สวน
ที่จําเปนอยางยิ่งคือ Coordinate Coversion เพราะจะทําการแปลงขอมูลพิกัดปจจุบันเปนขอมูลพิกัด
ตามที่ระบุได มิฉะนั้นขอมูลจะไมตรงกับความเปนจริงที่เกิดขึ้นถาขอมูลพิกัดไมตรงกับ MapGuide 
Server เมื่อกําหนดคุณสมบัติตางๆเสร็จก็สามารถสงออก Spatial Data File ในรูปแบบนามสกุล 
.SDF ซึ่งพรอมนําไปใชงานไดการสงออกขอมูลที่เปน Raster ในที่นี้หมายถึงภาพถายทางอากาศนั้น
สิ่งสําคัญคือขอมูลพิกัดโลกอางอิงของแผนภ าพถายทางอากาศของแตละแผนภาพหรือไฟลตอง
สอดคลองกับเสนทางที่ทําการบันทึกเสนทางดวยระบบพิกัดนํารองดาวเทียม (GPS Tracking) การ
สงขอมูลภาพออกทําไดโดย เลือก Image -> Export -> World File

รูปที่ 18 การสงออกขอมูลพิกัดภาพถายทางอากาศ
หลังจากสงออกขอมูลพิกัดภาพถายทางอากาศเสร็จสิ้นก็จะไดกลุมของภาพถายและพิกัดอางอิงตาม
ความเปนที่สงออกจาก AutoCAD Map เนื่องจากภาพถายทางอากาศจําเปนตองมีความละเอียดใน
หลายระดับ ในการแสดงผล มาตราสวนที่ต่ํายอมนําเสนอภาพถายทางอากาศที่ละเอียด มาตราสวน
ที่สูง ยอมเสนอภาพถายทางอากาศที่ละเอียดนอย และแปรผันกับขนาดไฟลของภาพถายทางอากาศ
ดวยภาพที่มีความละเอียดสูงมีขนาดไฟลใหญเปนตน วิธีการทํากลุมภาพ ในระดับความละเอียด
ตางๆ ใชโปรแกรม Raster Workshop การสราง ในการสรางนั้นจะนําไฟลขอมูลพิกัดซึ่งสงออกมา
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จาก AUtoCAD Map ซึ่งมีชื่อวา Raster Image Catalog File (IRC) ซึ่งเปนไฟลบรรจุขอมูลภาพถาย
ทางอากาศและพิกัดอางอิง ดานลางซาย และดานขวาบนของภาพถายทางอากาศไวแลวเรียบรอย
ภายในเปนรายการ เมื่อตองการทํากลุมภาพที่มีความละเอียดต่ําลงก็เพียงแตนําไฟล Raster Image 
Catalog File (IRC) เขาสู Raster Workshop แลวทําการกําหนดความละเอียดของไฟลกลุมใหมที่
ตองการจากนั้นระบบก็จะจัดการให

รูปที่ 19 การนํา Raster Image Catalog File (IRC) เขาสู Raster Workshop
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รูปที่ 20 การกําหนด Sub Sample
การกําหนด Sub Sample คือการสรางกลุมไฟลใหมที่มีความละเอียดต่ํากวากลุมไฟลตนฉบับจุด
ประสงคคือการนําไปใชในการดูภาพที่ในระดับที่มาตราสวนสูงขึ้นใหแปรผันกับความละเอียดของ
ภาพถายทางอากาศ ในที่นี้ กําหนดใหเปน 100% 75% 50% และ 25% ตามลําดับ

การผสมผสานขอมูล Spatial Data File และ None Spatial Data file (Maguide Author)
ในสวนนี้จะกลาวถึงการทําเลเยอรและการเชื่อมขอมูลที่อยูในรูปฐานขอมูล เขากับ จุด เสน หรือ รูป
ปด ซึ่งการทํางานสวนนี้จะสัมพันธกับการเซต Mapguide Server เพราะตองเซตฐานขอมูลทั้ง
Spatial Data File และ None Spatial Data file ใหสัมพันธกันในการสราง กอนอ่ืนใน Mapguide
Server ตองระบุ Path ที่ถูกตองดังนี้
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                           รูปที่ 21 เปนการระบุ Directory ที่เก็บภาพถายทางอากาศ
จากรูปจะสังเกตเห็นไดวาเมื่อตองการมากกวาหนึ่ง Directory ใหขั้นดวย ; (semicolon)เพื่อสามารถ
ระบุ Path ไดมากขึ้นกรณีไฟลรูปภาพอยูตาง Directory และเชนเดียวกันกับการระบุ Data Source
Name ก็สามารถทําไดเหมือนกันคือการระบุ Path ที่เก็บ Spatial Data File ในรูปแบบ SDF ไวในที่
ตางๆก็สามารถระบุได กรณีนี้ตองระบุชื่อ Data Souce Name ที่ตองการจะติดตอดวย ซึ่งจะมีอยู 2
ลักษณะยอยคือขอมูลที่เกี่ยวขอกับฐานขอมูลและขอมูลที่ไมเกี่ยวของกับฐานขอมูล ซึ่งขอมูลที่เกี่ยว
ของจําเปนตองเรียกฐานขอมูลเพื่อเชื่อมตอกับ Spatial Data File เพื่อใชในการสรางความสัมพันธ
ระหวางขอมูลที่อยูในรูป  Spatial Data File และ None Spatial Data File เพื่อประโยชนในการใช
งานÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 22 กําหนดชื่อของ Data Source Name

รูปที่ 23  Spatial Data File เรียกใชฐานขอมูล
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รูปที่ 24 การเชื่อมตอ Spatial Data File เขากับ Data Source Name ผาน ODBC
ในกรณีไมเรียกใชฐานขอมูลเชื่อมตอกับ Spatial Data File ก็สามารถระบุเพียง Path ซึ่ง
Spatial Data File (SDF) นั้นๆอยู นอกจากนี้ในสวนอ่ืนๆของหนาคุณสมบัติของ Mapguide Server 
ยังระบุให กําหนด Logging เพื่อทําการตรวจสอบการใชงานของระบบ การกําลังสิทธิการเขาถึง 
โดยการกําหนดผูใชงาน (User) หรือกลุมของ (User Group) รวมไปถึงสิทธิที่มีขอจํากัดของแตละ
คนที่มีสิทธิ ยกตัวอยางเชน บุคคลนี้สามารถดูไดจากระดับมาตราสวน 1:10000 ถึง 1:5000 เทานั้น
เปนตน ทายสุดคือสวน Access Key คือสวนที่ปองกันการ เขาใชระบบ โดยการระบุคียในการเขา
และกําหนดชวงวันเลาที่อนุญาตใหเขาใชงานในระบบวาใหอนุญาตในชวงใดบาง
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รูปที่ 25 สวนจัดการคุณสมบัตของ Mapguide Server ในสวน Logging

รูปที่ 26 สวนจัดการผูใชงานหรือกลุมผูใชงาน
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รูปที่ 27 สวนจํากัดสิทธิการเขาถึงขอมูลระดับใดโดยอางอิงจากมาตราสวน
ในสวน Mapguide Author จะทํางานประสานกับ Mapguide Server ฉะนั้นการเซตคาตางๆใน 
Mapguide Server จะสงผลถึง Mapguide Author เมื่อมีการเรียกใชขอมูลที่แสดงใน MapGuide 
Author จะถูกตอง หรือผิดพลาดขึ้นอยูกับ Mapguide Server การระบุที่อยูที่ถูกตองของ Spatial Data 
File ไมวาจะเปน Vector หรือ Raster Format จะตองสมบูรณ รวมไปไปฐานขอมูลที่จะทําการเชื่อม
ตอตองถูกตอง และที่สําคัญคือระบบพิกัดที่ต้ังคาใน Mapguide Server ตองสัมพันธกับ ขอมูลที่สง
ออกมาจาก AutoCAD Map จากนั้นจึงเร่ิมตน จัดสรางความสัมพันธระหวาง Spatial Data File และ 
None Spatial Data File ภายใต MapGuide Author การสรางแผนที่ใน Autodesk Mapguide
จะจัดสรางในรูปแบบนามสกุล MWF (Map Window File) การเร่ิมตนดวยการสรางชั้นในการนํา
ไฟลขอมูล Spatial Data เขาสูแผนที่ในการสรางเลเยอรนั้นมี 2 รูปแบบใหญๆคือเลเยอรและกลุมเล
เยอร การสรางเลเยอรโดยปกติแลวจะแบงเปนขอมูล Vector และ Raster อันไดแก จุด เสน และเสน
รูปปด ภาพถาย และตัวหนังสือ ซึ่งขอมูลเหลานี้ถูกอางพิกัดไวแลวจากการสรางในตอนแรก ฉะนั้น
ขอมูลที่ถูกตองในตอนแรกจะมีความสําคัญมาก เพราะจะสงผลใหขอมูลที่ใชงานในสวน
ตางๆถูกตองไปดวยเชนกัน การสรางเลเยอรเร่ิมตนดวยการต้ังชื่อเลเยอร ต้ังชื่อที่ตองการใหแสดง
กรณีนี้ต้ังชื่อเลยเยอรวา “Building” และชื่อที่จะใหแสดงวา “อาคาร” แลวเลือกรูปแบบการแสดงผล
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รูปที่ 28 การสรางชั้น (Layer)
ของเลเยอรนั้นๆวา จะใหแสดงผลแบบใด แบบ Dynamic หรือ Static หมายถึงการกําหนดใหแผนที่
แสดงจุดนั้นๆ ตลอดเวลาหรือเปลี่ยนไปไปตามเงื่อนไขที่กําหนด สวน Make Map Features
selectable หมายถึงการอนุญาตใหผูใชงานเลือกใชขอมูลจุดนั้นๆได สวน Draw Priority หมายถึง
การกําหนดวาจะใหเลเยอรไหนวาดกอนหรือหลังโดยปกติแลว ปลอยใหเปนคาแกรมตั้งมาเปนตัว
จัดการ

รูปที่ 29 การกําหนดชื่อเลเยอรและการกําหนดคุณสมบัติตางๆ
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รูปที่ 30 การเชื่อมตอฐานขอมูลเขากับจุด
ในสวนนี้จะระบบ Data Source และตาราง รวมไปถึงฟลดที่ตองการอางอิงถึงนอกจากนี้การระบุ
ตําแหนงของจุดบนแผนที่เกิดจาก พิกัดที่เก็บไวในฐานขอมูลจึงจําเปนตองเรียกใชตําแหนงพิกัดดัง
กลาวในกรณีนี้เรียกใชฟลด LAT และ LON

รูปที่ 31 การเรียกใชพิกัดในฐานขอมูลเพื่อระบุตําแหนงบนแผนที่
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รูปแบบในการนําเสนอก็มีความสําคัญวาจะนําเสนอรูปแบบใดเชนการกําหนดมาตราสวน
ใหมองเห็นขอมูลเฉพาะชวงมาตราสวน หรือ อนุญาตใหมองเห็นทั้งหมด

รูปที่ 32 การกําหนดรูปแบบของขอมูลแบบจุด (Point)
กําหนดชวงของขอมูลก็จะสามารถแยกประเภทของขอมูลไดเชนเดียวกันวาขอมูลน้ันเปน
อาคารประเภทใด เชน อาคารบานพักอาศัย ศูนยการคา หรืออ่ืนๆ โดยการกําหนดหัวขอ
หลักที่ตองการอางอิงตามฐานขอมูล

รูปที่ 33 การกําหนดหัวขอหลัก ในการแสดงอาคารประเภทตางๆ
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ขั้นตอไปเปนการกําหนดภาพสัญลักษณใหกับจุดที่ไดกําหนดตามหัวขอหลักของอาคารวาชวงคานี้
ตองการรูปแบบอาคารแบบใด ตามไฟลสัญลักษณที่กําหนดใหหรือสรางสัญลักษณขึ้นใหมใหสอด
คลองกับความตองการ

รูปที่ 34 การกําหนดชวงคาเพื่อกําหนดประเภทอาคารและสัญลักษณ
ในการกําหนดรูปแบบสัญลักษณสามารถสรางสัญลักษณขึ้นใชเองไดหรือใชสัญลักษณมาตรฐานที่
มีอยูในโปรแกรม และกําหนดคุณสมบัติของสัญลักษณตามตองการ
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ภาคผนวก ค

องคประกอบของการสรางระบบสารสนเทศภูมิศาสตรประกอบดวย 3 สวนหลักๆคือ
1. สวนสราง หรือ สวนจัดทําขอมูลทางภูมิศาสตร สวนนี้จะประกอบดวยขอมูล 2 ประเภทคือ ขอ

มูลซึ่งอยูในรูป
จุด เสนสาย รูปปด (Point ,Line , Polygon) หรือที่เรียกกันทั่วไปวา Vector format และ ขอมูล
ซึ่งอยูในรูปภาพถายทางอากาศหรือ ที่เรียกกันทั่วไปวา Raster Format

1.1 ขอมูลที่อยูในรูป Vector format ไดมาจากการ บันทึกเสนทางดวย ระบบพิกัดนํา
รองดาวเทียมหรือที่เรียกกันทั่วไปวา GPS (Global Position System) ดวย
โปรแกรม Cetus และ จาก จุดหรือเสนสายที่สรางขึ้นใน AutoCAD Map รวมไป
ถึงพิกัดของจุด ที่สรางขึ้นดวยการระบุตําแหนงดวยพิกัดในฐานขอมูล

1.2 ขอมูลที่อยูในรูป Raster Format ไดรับการเอ้ือเฟอจากเทศบาลนครเชียงใหม แต
ทั้งนี้ภาพถายทางอากาศดังกลาวจําเปนตองมีการปรับแตงเพื่อใหเขากับตําแหนง
พิกัดจริงบนโลกดวยการใชเทคนิค Rubber Sheet โดยซอฟแวรชื่อ CAD Overlay
ทําการยืดตําแหนงเขาสูพิกัดที่ถูกตองซึ่งอางอิงดวย ระบบพิกัดนํารองดาวเทียม
(GPS) หลังจากนั้นขอมูลทั้งที่อยูในรูป Vector และ Raster format ก็พรอมที่จะถูก
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นําเขาไชงานในสวนตอไปโดยการสงออกผานขอมูลไปยังโปรแกรมจัดการขอมูล
สารสนเทศภูมิศาสตร

2. สวนจัดการขอมูลสารสนเทศภูมิศาสตร ประกอบดวย 3 สวนหลักคือ
2.1 สวนผสมผสานขอมูลที่อยูในรูปเชิงภูมิศาสตร (Spatial Data) และขอมูลซึ่งไมอยู

ในรูปเชิงภูมิศาสตร (None Spatial Data) กลาวคือสวนนี้ทําการสรางระบบสาร
สนเทศทางภูมิศาสตรจากขอมูลซึ่งไดรับจากสวนที่จัดสรางเสร็จ ใหอยูในรูปแบบ
ที่ตองการในการใชงาน สวนนี้เรียกวา MapGuide Author

2.2 สวนขับเคลื่อนขอมูลสารสนเทศภูมิศาสตร (GIS Engine) สวนนี้ทําหนาที่เปนเชิฟ
เวอรในการใหบริการ แกสวนที่ 3 คือสวนผูใชงาน และเปนสวนที่ทําหนาที่สื่อ
สารระหวาง Internet Information System (IIS) ในการใหบริการผูรองขอใช
บริการผานเครือขายอินเตอรเนต ซึ่งสวนนี้เรียกวา MapGuide Server

2.3 สวนเชื่อมตอโลกภายนอกผานเครือขายอินเตอรเนต Internet Information System
(IIS) สวนนี้ถือวาเปนสวนที่สําคัญที่ทําใหการเขาถึงขอมูลสารสนเทศภูมิศาสตร
ไมถูกจํากัดเพียงวงแคบๆ แตสามารถตอบสนองความตองการการใชงานผานเครือ
ขายอินเตอรเนตได แตก็ลืมเสียไมไดนั่นคือการกําหนดสิทธิการเขาถึงขอมูล ตอง
มีความรัดกุม สูงตามไปดวยเชนกัน

3 สวนผูใชงานนั้นประกอบดวย 2 สวนหลักคือ
3.1 โปรแกรมบราวเซอร มาตรฐานทั่วไป ซึ่งในกรณีนี้ใช Internet Explorer เปนหลัก

ซึ่งใชในการดูขอมูล แกไข อัพเดท สืบคน ซึ่งอาศัยความสามารถของเครื่อง
คอมพิวเตอรนอยมาก ฉะนั้นผูใชงานสามารถใชงานไดเพียงจัดหาเครื่องที่เชื่อมตอ
ระบบอินเตอรเนตไดและมีบราวเซอรมาตรฐานรองรับ

3.2 MapGuide Plug-in เปนโปรแกรมเสริมความสามารถของบราวเซอรปกติใหมี
ความสามารถใชงาน ขอมูลสารสนเทศภูมิศาสตร

จะเห็นไดวาทั้งสามสวนหลักทําหนาที่ของแตละสวน แลวสงขอมูลผานไปยังสวนถัดไปเพื่อให
บริการ ซึ่งแตละขั้นตอนของแตละสวนก็จะมีสวนยอย ในการจัดทํา รวมถึงวิธีการซึ่งไดมาซึ่งขอมูล
สารสนเทศภูมิศาสตร การผนวกขอมูลเชิงพื้นที่ (Vector and Raster) เขากับขอมูลซึ่งไมอยูในรูปพื้น
ที่อาทิ ขอมูลอาคารสถานที่ ขอมูล สถิติเชิงตัวเลข อ่ืนๆ แลวสรางสิ่งที่ตองการ ใหตอบสนองกับ
งานองคกร ในบางครั้งขอมูลที่ไดจากระบบ เปนความรูใหมที่อาจจะอยูนอกเหนือความคิดปกติซึ่ง
นี่ความสามารถหลักของ ระบบสารสนเทศภูมิศาสตร
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ภาคผนวก ง
การเชื่อมตอ Open Database Connectivity (ODBC)

การเชื่อมตอฐานขอมูลเขากับระบบภูมิศาสตรถือวาเปนสิ่งสําคัญอีกประการหนึ่งในการเชื่อมตอนั้น
จะกระทําที่ เชิฟเวอรหลัก เพื่อเชื่อมฐานขอมูลเขากับแผนที่ภูมิศาสตรและ เวบเชิฟเวอร (IIS) วิธี
เชื่อมตอกระทําโดย วินโดวเอ็นที 4.0 ขึ้น โดยไปที่ Start -> Setting -> Control Panel

รูปที่ 1 การเชื่อมตอ ODBC

เลือกที่เมนู System DSN เพื่อทําการสราง Data Source ใหม จากนั้นเลือก Add เพื่อทําการสราง
ทําการเลือก MySQL ODBC ในการเชื่อมตอฐานขอมูลจากนั้นคลิ๊กเลือก Finish แลวไปยังขั้นตอไป
ระบุชื่อฐานขอมูลที่ตองการตั้ง ระบุที่อยูของขอมูล  ในที่นี้ localhost หมายถึงเคร่ืองที่ใชอยูปจจุบัน
ซึ่งสามารถระบุเปน ไอพี แอดเดรส ได เลือก ชื่อฐานขอมูล ระบุชื่อและ รหัสผานผูใชงานและ
พอรตที่เชื่อมตอ คาปกติจะถูกเซตไวที่ 3306ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 2  การเพิ่ม System Data Source Name (DSN)

รูปที่ 3 MySQL ODBC Driver
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รูปที่ 4 ระบุรายละเอียดในการเชื่อมตอ ODBC

จากนั้นทําการทดสอบ Data Souce วามีการเชื่อมตอสําเร็จหรือไมโดยการคลิ๊กที่ Test Data Souce
เพื่อทําการทดสอบ ซึ่งถาผลการทดสอบสําเร็จ Data Source ก็พรอมที่จะใชงานได

รูปที่ 5 ผลการทดสอบเชื่อมตอ Data Source สําเร็จ
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การใช MySQL Administrator for Windows

เนื่องจากการสราง ตาราง ใน MySQL มีความยุงยากพอควรกรณีที่ผูใชงานไมคุนเคยกับ MySQL
ดังนั้น MySQL Administrator for Windows จึงถูกสรางขึ้นเพื่ออํานวยความสะดวกในการใชงาน
ไมวาจะเปนการสรางฐานขอมูล การสรางตาราง รวมไปถึงการเขาถึงฐานขอมูลรายชื่อผูใชงาน ฐาน
ขอมูล ก็สามารถจัดการไดงายยิ่งขึ้น เมื่อติดต้ัง MySQL เสร็จ จากนั้นก็คลิ๊กที่ MySQL dministrator
for Windows จะปรากฏ Sever list keyทําการปอน Server list key  เพื่อเขาเชื่อมตอกับ MySQL
Server

รูปที่ 1 ระบุ Server List Key เพื่อเชื่อมตอ MySQL

เมื่อระบุ Server List Key กด OK จากนั้นจะปรากฏหนาตางเพื่อทําการเพิ่มเชิฟเวอรเขาไป MySQL
Administrator เพื่อพรอมในการจัดการ ขั้นนี้โปรแกรมก็จะใหกรอกขอมูล ชื่อเชิฟเวอร ชื่อโฮสหรือ
ไอพีแอดเดรสที่ตองการเชื่อมตอ รวมไปถึงพอรตและ ชื่อ รหัสผานเพื่อเชื่อมตอ MySQLÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 2 รายละเอียดการเชื่อมตอ MySQL

รูปที่ 3 ทําการเชื่อมตอ MySQL Server
เมื่อทุกขั้นตอนไดทําเสร็จสิ้น ขั้นตอนสุดทายคือเลือกที่ Server ในที่นี้ชื่อ GIS จากนั้นกดปุมขวา
ของเมาสเพื่อทําการเชื่อมตอฐานขอมูล MySQL Database Server กับ MySQL Administrator for
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รูปที่ 4 สรางฐานขอมูลใน MySQL Server

Windows แตในกรณีเปนการเชื่อมตอฐานขอมูลในเครื่องเดียวกัน ถาเปนกรณีตางเชิฟเวอรก็
สามารถทําไดเชนเดียวกันโดยระบุเชิฟเว อรที่จะทําการเชื่อมตอดวยชื่อหรือ ไอพีแอดเดรสจากนั้น
ทําการสรางฐานขอมูลใหมใน MySQL Server ผานทาง MySQL Administrator โดยการคลิ๊กที่ 
Create a Database แลวระบุชื่อ ฐานขอมูลที่ตองการจะปรากฏชื่อฐานขอมูลขึ้นมา
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รูปที่ 5 การสรางตารางในฐานขอมูล

เมื่อสรางฐานขอมูลเสร็จก็ทําการสรางตารางในฐานขอมูลในกรณีนี้สรางฐานขอมูล Account จาก
นั้นตาราง account ก็จะปรากฏในฐานขอมูล mapdb เมื่อตองการเพิ่มเติมแกไขตารางก็สามารถ
กระทําไดโดย กดปุมขวาของเมาสแลวทําการเลือก Table maintenance
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รูปท่ี 6 การปรับปรุงแกไขตาราง

รูปที่ 7 ตารางที่สามารถปรับปรุงแกไขขอมูลตางๆ
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ในการสรางเลเยอรที่เปนภาพถายหรือ Raster นั้นสามารถทําไดดังนี้สรางเลเยอรโดยกําหนดเปนเล
เยอรหรือกลุมเลเยอร (Group Layer)

รูปที่ 35 การสรางกลุมเลเยอร
การสรางกลุมเลเยอรเพื่อจุดเลเยอรอยูในกลุม เชนกลุมเลเยอรของภาพถายทางอากาศซึ่งมีมาตรา
สวนในการมองเห็นที่แตกตางกันในแตละมาตราสวน

รูปที่ 36 การกําหนดเลเยอรในกลุมเลเยอรหลักในรูปแบบ Raster Layer
จากรูปเปนการกําหนดขอมูลเลเยอรภาพถายทางอากาศ ซึ่งมีขนาดมาตราสวนที่กําหนดใหมองเห็น
ไดในระดับมาตราสวน 1:2000 จนถึง 1:5000 หนวย ซึ่งการแบงกลุมความละเอียดในการมองเห็น
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ภาพถายทางอากาศจะชวยลดการทํางานของเชิฟเวอรในการประมวลผลและสงผลถึงความเร็วใน
การเขาถึงขอมูลในระบบอีกดวย

รูปที่ 37 การระบุไฟลที่เก็บขอมูลภาพถายทางอากาศ
ขอมูลภาพถายทางอากาศถูกกําหนดดวย Raster Image Catalog File (IRC) ใน IRC ไฟลจะระบุ
Path  ของไฟลภาพถายทางอากาศและพิกัดอางอิงมุมลางซาย และขวาบนของภาพถายทางอากาศ
ตลอดจนคุณสมบัติของภาพถายทางอากาศนั้นๆวามีคุณสมบัติอยางไร

รูปที่ 38 การกําหนดชวงมาตราสวน
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รูปที่ 39 การกําหนดชวงมาตราสวนที่ตองการใหสามารถมองเห็นไดในแผนที่
ภาพถายทางอากาศจะถูกกําหนดให สรางใหมไดตามสัดสวนการยอขยายที่กําหนดในสวนทายสุด
ของการสรางเลเยอรทุกชนิดก็จะมีสวนการักษาความปลอดภัยในเลเยอรนั้นๆ ในการปองการ การ
เขาถึงเลเยอร จะมีรหัสผานหรือไม ก็ไดถาตองการใหมีรหัสผานก็ใส Access Key เขาไปในสวน 
Security ของเลเยอร เมื่อมีการเรียกใช Layer นั้นๆแผนที่ก็จะถามรหัสผานจากผูใชงานเพื่อเขาใจเล
เยอรดังกลาว

คุณสมบัติหลักของแผนท่ีสารสนเทศทางภูมิศาสตร
คุณสมบัติหลักของแผนที่สารสนเทศทางภูมิศาสตร เพื่อการแจงขาวและสถิติอาชญากรรม

ของตํารวจภูธรเชียงใหมมีองคประกอบดังนี้

รูปที่ 40 บริเวณกําหนดคุณสมบัติทั่วๆไปของแผนที่
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ประกอบดวย ชื่อแผนที่ พื้นสีหลัง ตลอดจนบริเวณพื้นที่ ที่ตองการแสดงภาพแผนที่ หนวยที่ใชใน
แผนที่เปน Metric ซึ่งกําหนดไดใน Preference ของแผนที่หลักโดยการเลือก File -> Preference
จากนั้นระบุหนวยที่ใชเปน Metric การระบุตําแหนง Mouse Position ก็สามารถเลือกไดเชนกันโดย
การเลือกแบบ Latitude / Longtitude หรือ UTM ที่สรางจากไฟลตนฉบับใน AutoCAD MAP
การกําหนดพิกัดมีขอควรระวังพิกัดตองสอดคลองกับตนฉบับที่สรางเชน ภาพถายทางอากาศถูก
สราง Raster Image Catalog File เปน WGS 1984, UTM Zone 47 North ในแผนที่ก็ตองถูกต้ังหนวย
ของพิกัดใชแบบเดียวกัน จะไมเกิดปญหาขอมูลภาพถายทางอากาศ ไมแสดงผลเพราะแสดงผลไม
ตรงตามตําแหนงที่ควรจะเปนในแผนที่

รูปที่ 41 การเซตคา Coordinate System ProjectionÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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การสรางรายงานจากวัตถุที่เลือกในแผนที่ หลักการคือ เลือกวัตถุบนแผนที่นําคาที่ไดจากวัตถุไปสืบ
คนขอมูลในฐานขอมูลที่เชื่อมตอกับวัตถุนั้นๆ เชน จุดนี้คือพิกัดเทาใด แลวสืบคนหาชื่ออาคาร หรือ
ขอมูลอ่ืนๆซึ่งเกี่ยวของสัมพันธกับอาคารนั้นๆ

รูปที่ 42 การทํารายงานจากวัตถุ (Object)
การยอหรือขยายไปยังตําแหนงที่ตองการ ก็เปนสวนสําคัญอีกกรณีหน่ึงในการคนหามีวิธีการคลาย
กับการสืบคนใน SQL Command แตเปนการคนในเชิงวัตถุโดยอางอิงจากพิกัดในฐานขอมูล

รูปที่ 43 การยอขยายไปยังสวนที่ตองการ (Zoom Goto)
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สวน Popup Menu เปนสวนเสริมเพื่อสรางความสะดวกในการใชงานแผนที่ วิธีการใชเพียงกดปุม
ขวาของเมาสบนแผนที่จะปรากฏ PopUp Menu ขึ้นเพื่อใหเลือกใชงานตามตองการไดเมื่อเลือกใช
งานโปรแกรมก็จะทํางานตามที่ Action ที่ถูกกําหนดใน PopUP Menu วาใหทําอะไรบาง

รูปที่ 44 การแกไขเปลี่ยนแปลง Action สวน PopUP Menu
สวนรักษาความปลอดภัยของแผนที่หลัก เพื่อปองกันการเขามาแกไขเปลี่ยนแปลงคุณสมบัติตางๆ
ในแผนที่สวนนี้ถือวาเปนสวนสําคัญ เนื่องจากผูใชสามารถเขามาแกไขคุณสมบัติตางๆในแผนที่ได
ทั้งหมดถาทราบ Access Key หลักของแผนที่นี้
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รูปที่ 45 สวนปองกันความปลอดภัยของแผนที่หลัก

บทสรุปการไดมาซึ่งขอมูลสารสนเทศทางภูมิศาสตร
การไดมาซึ่งขอมูลสารสนเทศทางภูมิศาสตรนั้นไดมาจาก 2 สวนหลักคือขอขอมูลซึ่งอยูใน

รูป Vector และขอมูลซึ่งอยูในรูป Raster หรือที่เรียกกันวา (Spatial Data file) การนําขอมูลเขานั้น
ประกอบ 2 วิธีการคือการนําผานเครื่องอานพิกัดดาวเทียม (GPS) แลวการ Insert ขอมูลเขาตรงๆใน
AutoCAD MAP ซึ่ง AutoCAD Map ถือวาเปนสวนสรางแผนที่ จากนั้นทําการปรับแตงพิกัดใหเขา
กับตําแหนงจริงของโลก เลือกใช Coordinate Projection System ที่เหมาะสมกับพื้นที่ ในที่นี้เลือก
ใช Thailand west of 102d East; Indian 1975 Datum / และ Latitude / Longtitude  WGS 1984 เปน
Coordinate Projection System เมื่อขอมูลพรอมที่จะสงออกก็จัดการสงออกไปยัง MapGuide Server
เพื่อทํางานในขั้นตอนตอไป ขั้นนี้ก็เซตคาตางๆที่เกี่ยวของกับ SDF File และ Raster file
กําหนด Path และ ฐานขอมูลที่จะเชื่อตอใหถูกตองกอน เรียกใชขอมูลโดย Mapguide Author ซึ่ง
เปนสวนสุดทายในการจัดการระบบสารสนเทศทางภูมิศาสตร ในการสรางสิ่งตอบสนองความ
ตองการของผูใชระบบในรูปแบบตางๆ ในที่สุด จากนั้นก็นําเสนอตอผูใชงาน.
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ภาคผนวก ข
การเชื่อมตอ Autodesk MapGuide กับ Internet Information Server

การเชื่อมตอ AutoDESK MapGuide Server กับ Internet Information Server (IIS)

จุดประสงคเชื่อมตอระบบเพื่อสามารถรองรับการใชงานในระบบเน็ตเวอรคได ซึ่งอาจเปนเครือขาย
เฉพาะที่ LAN หรือแมกระทั่งระบบอินเตอรเนต (WAN) การเชื่อมตอระบบอินเตอรเนตอาศัยความ
สามารถของ IIS แตความสามารถของระบบแผนที่อาศัยความสามารถของ MapGuide Server วิธี
การเปด IIS จากนั้นสราง Virtual directory ดังภาพที่แสดง จุดสําคัญคือ ระบุให Virtual directory
ดังกลาวใหมีคุณสมบัติ Execute ไดเพื่อเรียกใชความสามารถของ MapGuide Server ที่เรียกวา
MapAgent เมื่อเสร็จขบวนการนี้ระบบก็พรอมที่ใหบริการระบบสารสนเทศภูมิศาสตร
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ภาคผนวก ฉ

คูมือการใชงาน
ระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชาญากรรม

 ของตํารวจภูธรจังหวัดเชียงใหม

ระบบที่พัฒนาขึ้น ไดพัฒนาขึ้นเพื่อตอบสนองความตองการ การใชระบบสารสนเทศใน
การปองกันปราบปรามอาชญากรรม ตลอดถึงการวางแผนจัดการในดานอ่ืนๆที่เกี่ยวของ ทั้งคดี
อาญาทั่วไป และคดีจราจร ของตํารวจภูธรจังหวัดเชียงใหม ซึ่งระบบพัฒนาขึ้นเพื่อรายงานผล สืบ
คนขอมูลผลการรายงาน เชื่อมโยงกับขอมูลทางภูมิศาสตร รวมไปถึงการมีสวนรวมของประชาชน
ในการแจงขาวหรือเบาะแสอันเปนประโยชน ตอเจาหนาที่ ภายในเขตเทศบาลนครเชียงใหม

1. ความตองการของระบบและการใชงานทั่วไป
ระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชาญากรรมของตํารวจภูธรจังหวัด
เชียงใหม มีลักษณะเปน Client <-> Server ในที่นี้จะกลาวถึง Client ความตองการของฝงผูใช
งานนั้น ตองมี Browser มาตรฐานทั่วไป ซึ่งขอแนะนําใหใช Internet Explorer 6.0 ขึ้นไป
และมี MapGuide Plug-in ติดต้ังที่ Browser ดังกลาวเพื่อสนับสนุนการใชงานแผนที่แบบ
Dynamic และมีระบบเนตเวอรคที่เชื่อมตอยัง MapGuide Server เพื่อทําการเรียกใชระบบ ใน
กรณีตองการสั่งพิมพรายงาน จําเปนตองมีเคร่ืองพิมพ ติดต้ังดวย ขอแนะนําเปนเคร่ืองพิมพสี
หรือ เลเซอรปรินซเตอร เมื่อติดต้ัง Plug-in และเชื่อมตอระบบกับเชิฟเวอรแลว ก็เปด URL        
(Universal Resource Locator) ในชองบราวเซอร จากนั้น คลิ๊กที่ ระบบสารสนเทศมิศาสตร

รูปที่ 1 URL ของระบบสารสนเทศภูมิศาสตร
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เมื่อกดที่ ระบบสารสนเทศภูมิศาสตร จะปรากฏหนาหลักของระบบสารสนเทศภูมิศาสตรเพื่อการ
แจงความและสถิติอาชญากรรม ดังนี้

รูปที่ 2 หนาจอหลักของระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชญากรรม
การใชงานระบบจะแบงออกเปน 2 สวนหลักๆคือภาคประชาชนทั่วไป และเจาหนาที่

ตํารวจผูรับผิดชอบ ในกรณีประชาชนทั่วไปสามารถ เลือกปุมประชาชน เพื่อเขาไปใชระบบไดทัน
ทีแตในกรณีที่เปนเจาหนาที่ตํารวจจะตองมีรหัสผานเพื่อเขาใชระบบดังกลาว

2. การใชงานกรณี ประชาชนทั่วไป
ในกรณีประชาชนทั่วไป สามารถเขาใชงานไดทันทีโดยไมมีรหัสผานใดๆ เพื่อเขาไปแจงขาวหรือ
เบาะแส เสนอแนะ ขอมูลอันเปนประโยชน ตอเจาหนาที่ตํารวจ ซึ่งเมื่อเลือกกดตรง
ประชาชน ก็จะปรากฏหนาตางใหมขึ้นมา ซึ่งหนาตางจะประกอบดวย 3 สวนหลักๆคือสวนซายมือ
คือสวนแผนที่ภูมิศาตร สวนขวามือเปนสวนคําแนะนําการใชงานระบบ และสวนดานลางกรอกขอ
มูลเพื่อแจงขาว หรือเบาะแส คําแนะนําตางๆ  ซึ่งการเขาสูระบบในครั้งแรกโดยไมมีการติดต้ัง Plug-
in จะทําใหสวนแผนที่ไมสามารถเห็นแผนที่ได แตจะมีคําแนะนําในชองดานซายมือ ใหติดต้ัง Plug-
in ซึ่งสามารถทําไดโดยการโหลดไปตัดต้ังเอง หรือใหติดต้ังอัตโนมัติในบราวเซอรของผูเรียกใชก็
ได โดยกดเลือกกดหัวขอที่ตองการวาจะติดต้ังแบบใดในชองดานซายมือไดทันที ซึ่ง การติดต้ัง
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Plug-in จะใชเวลานานหรือไมขึ้นอยูคุณภาพสายในการเชื่อมตอระบบวามีความเร็วเพียงโดยปกติ
การติดต้ังแบบอัตโนมัติ ใชเวลาไมเกิน 5 นาที ที่ความเร็วในการเชื่อมตอเนตเวอรคโดยใชความเร็ว
โมเด็ม 56 Kbps หรือการโหลดไป Plug-in เพื่อการติดต้ังดวยตนเอง ใชเวลาไมเกิน 15 นาทีในคุณ
ภาพการเชื่อมตอเดียวกัน ในสวนดานลางของจอภาพจะเปนคําแนะนําทั่วไป ในการใชงานของ

ประชาชนทั่วไป วามีวิธีการใชงานอยางไร ดังนี้
กรุณากรอกขอมูลขางลางนี้ตามความเปนจริง เพื่อประโยชนในการปฏิบัติงาน
ไดอยางสะดวก รวดเร็ว และจะเก็บขอมูลดังกลาวเปน ความลับ
1. กรอกชื่อ ที่อยู หมายเลขโทรศัพท อีเมล ใหชัดเจน เพื่อความสะดวกในการติดตอกลับ
2. ในกรณีทานตองการระบุตําแหนงบนแผนที่ ขยายมาตราสวน 1:2000 - 1:4000 ณ.บริเวณ    
              ตําแหนงที่เกิดเหตุ จากนั้นระบุตําแหนง ซึ่งคาพิกัด (LAT/LON) จะปรากฏในฟอรม
3. ในกรณีทานไมตองการ ระบุตําแหนงทานสามารถขามขั้นตอนนี้ไปได
4. ระบุประเภทขอมูลที่แจง เชน ฆาตกรรม, ลักขโมย, ยาเสพติด, ลวงเกินทางเพศ อ่ืนๆ
5. กรอกรายละเอียดที่ตองการแจงใหชัดเจนที่สุดเทาที่จะเปนไปได
6. กดปุมแจงขอมูล เมื่อขอมูลพรอมสง
7. ระบบไดรับขอมูลระบบจะตอบกลับมายังผูแจงตามอีเมล แลวรอขบวนการทํางานตอไป

รูปที่ 3 ภาพหนาจอการการแจงขาว
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เมื่อติดต้ัง Plug-in เสร็จ Browser ก็จะสามารถใชงานระบบแผนที่ภูมิศาสตรได สังเกตุไดโดย
การมองเห็นภาพแผนที่ภูมิศาสตรที่ปรากฏ ขอบเขตของแขวงตางๆในเขตเทศบาลนคร
เชียงใหม นั่นหมายถึง Browser ของผูใชงานสามารถใชงานระบบไดแลว

รูปท่ี 4 การแจงขอมูล เบาะแสและคําแนะนําตางๆ

การแจงขอมูลกระทําโดยกดปุม เขาใชระบบ และขยายแผนที่ บริเวณจะแจง กรอกรายละเอียดตางๆ
ซึ่งชองรายละเอียด และประเภทขอมูลการแจง ตองระบุ กรณีตองการระบุในแผนที่แผนที่ที่จะทํา
การระบุ จะตองมีมาตราสวนอยูระหวาง 1:2000 ถึง 1:4000 เทานั้นเพื่อความแมนของการระบุสถาน
ที่ อันจะสงผลงายแกการตรวจสอบแกเจาหนาที่ผูรับผิดชอบ สวนขอมูลอ่ืนๆ ถาตองการระบุก็
สามารถระบุได แตถาไมตองการระบุก็สามารถเวนวางไวไดเชนกัน
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รูปท่ี 5 ระบบจะตอบรับเมื่อระบบไดรับขอมูลการแจงเบาะแสเรียบรอยแลว

รูปท่ี 6 ท่ีมาของระบบ และ วิธีการใชงานปุมและ Popup Menu
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วิธีการใชงานปุมตางๆในแผนที่

  สั่งพิมพแผนที่ออกทางเครื่องพิมพ เลื่อนแผนที่

  กอปป แผนที่ลงคลิปบอรด ยอแผนที่ตามคาแรก
ขยายแผนที่ วิธีการใชงานปุมตางๆและเมนูยอย
ยอแผนที่ ความเปนมาเกี่ยวกับระบบ

  กลับไปหนาหลัก

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่
Bookmarks บันทึกตําแหนง
Select เลือกวัตถุบนแผนที่
View ดูขอมูลตางๆ
Help คําแนะนําตางๆ และเซตคาพิกัด

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
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วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่
Bookmarks บันทึกตําแหนง
Select เลือกวัตถุบนแผนที่
Select เลือกวัตถุบนแผนที่

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
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3. การใชงานกรณี เปนเจาหนาที่ตํารวจผูรับผิดชอบ

                                      รูปที่ 7 หนาตางตรวจสอบสิทธิกอนเขาสูระบบ

การใชงานเร่ิมตนโดยเลือกหัวขอ เจาหนาที่ตํารวจ จากนั้นจะปรากฏหนาตางในการเขาสู
ระบบเพื่อใหผูใชงาน ตรวจสอบสิทธิในการใชงานกอนเขาสูระบบ จากนั้นกด Submit เพื่อ
ตรวจสอบกรณีมีรายชื่ออยูในระบบ ก็จะผานเขาไปใชงานไดตามปกติ แตถาไมมีรายชื่ออยู
ในระบบ หรือรหัสผานผิดระบบก็จะแจงกลับ เพื่อใหทําการปอน รายชื่อ และรหัสผานที่
ถูกตองใหม

กรณีรายชื่อผานก็จะปรากฏ หนาตางดังรูปที่ 8 ประกอบดวย 3 สวนหลักๆคือ สวนเมนู สวนราย
ละเอียดและสวนสุดทายเปนสวนแสดง แผนที่ภูมิศาสตร

สวนเมนูหลัก จะแบงผูใชออกเปน 3 กลุมคือ ผูใชที่เปนเจาหนาที่บันทึกขอมูล ซึ่งทํา
หนาที่บันทึกขอมูล คดีจราจร คดีอาญาทั่วไป บันทึกตําแหนงอาคารสถานที่สําคัญๆ กลุมที่ สองคือ
กลุมผูบริหาร มีความสามารถเพิ่มขึ้นที่จะคนขอมูลตางๆได อาทิ ขอมูลคดีอาญา ขอมูลคดีจราจร
ขอมูลอาคารสถานที่ ขอมูลการแจงเบาะแสตางๆ จากภาคประชาชน รวมไปถึงความสามารถที่จะ
เขาใชสวน วิเคราะหแผนที่ ซึ่งเปนสวน วิเคราะหและตัดสินใจ ในการจัดการงานของตํารวจภูธร
จังหวัดเชียงใหม
กลุมที่ 3 คือกลุมผูจัดการระบบ ถือวาเปนกลุมที่มีสิทธิสูงสุด ในการจัดการระบบ สิ่งที่เพิ่มเติมจาก
กลุมที่ 2 คือสิทธิในการจัดการ รายชื่อผูใชงานในระบบ เชน เพิ่มรายชื่อ ลบรายชื่อ เปลี่ยนแปลงขอ
มูล ของรายชื่อในระบบ และสวนที่เปนขาวสารซึ่งสงถึงผูใชงานระบบซึ่งเปนอักษรวิ่ง
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สวนรายละเอียด จะขึ้นอยูกับรายการเมนูที่ถูกเลือกวา สั่งใหทํารายการใด เชน บันทึกคดี
จราจร บันทึกคดีอาญาทั่วไป เปลี่ยนรหัสผาน เปนตน

สวนแสดงขอมูลแผนท่ีภูมิศาสตร เปนสวนแสดงขอมูลตามที่ผูใชงานเลือก เชน การยอ
ขยาย การแสดงหรือไมแสดง วัตถุตางๆบนแผนที่ถูกกําหนดดวย ชั้นของแผนที่ (Layer) รวมไปถึง
การสืบคนขอมูลตางๆ แลวใหแสดงผลการสืบคนในแผนที่ดวย

รูปท่ี 8 รูปหนาตางหลักเมื่อผานเขาสูระบบ
จากรูปที่ 8 เปนหนาหลักของผูใชงานที่เปนกลุมเจาหนาที่ตํารวจซึ่งจะแตกตางกันที่ รายการเมนู วา
รายชื่อใดมีสิทธิเทาใดในการใชงานระบบ สวนลางของหนาตางเปนสวนคําอธิบายในการใชงานใน
การบันทึกขอมูลคดี เพื่อสรางความเขาใจตอผูใชงานระบบ
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รูปท่ี 9 รูปการรายงานขาวคดีจราจร
การรายงานขาวคดีจราจรกระทําไดโดย กดเลือกเมนู บันทึกขอมูลคดีจราจร จากนั้นจะ
ปรากฏรายละเอียดตางๆใหปอน ซึ่งในสวนนี้จะมีสวนที่เปนพิเศษคือการระบุตําแหนงบน
แผนที่ ซึ่งกระทําไดโดยการขยายแผนที่ไปยังตําแหนงที่เกิดคดีจราจรใน มาตราสวนอยู
ระหวาง 1:2000 ถึง 1:4000 เพราะถาไมอยูในมาตราสวนนี้ระบบจะรายงานวา ใหขยายใน
ชวงมาตราสวนดังกลาว เมื่อมาตราสวนถูกตองก็ทําการระบุตําแหนงบนแผนที่ เพื่อระบุ
ตําแหนง จากนั้นขอมูล ละติจูด ลองติจูด ก็จะปรากฏในชองของรายละเอียด เพื่อบันทึก
ตําแหนงดังกลาวลงสูฐานขอมูล กรณีไมทราบตําแหนงที่เกิดเหตุสามารถขามขั้นตอนนี้ไป
ไดเชนเดียวกัน เมื่อปอนรายละเอียดตางๆครบก็ทําการ กดปุม Submit เพื่อบันทึกขอมูลคดี
จราจรเขาสูฐานขอมูล และจะปรากฏ คําตอบรับจากระบบวาไดบันทึกเสร็จแลว และ
สามารถทําการบันทึกใหมหรือ เลือกเมนูอ่ืนๆเพื่อใชงานตอไป

ในกรณีที่เปนการบันทึกขอมูลคดีอาญาทั่วไป บันทึกขอมูลอาคาร ก็ทํางานในลักษณะเดียว
กันกับการบันทึกขอมูลคดีจราจร ซึ่งจะแตกตางกันเฉพาะรายละเอียดของขอมูลที่จะทําการบันทึก
ลงในฐานขอมูลเทานั้นเอง
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รูปที่ 10 การบันทึกขอมูลคดีอาญาทั่วไป (บน)  รูปที่ 11 การบันทึกขอมูลตําแหนงอาคาร (ลาง)
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รูปท่ี 12 การตอบรับการบันทึกขอมูลอาคาร และ การเปลี่ยนรหัสผาน
เมื่อขอมูลที่ถูกบันทึกลงฐานขอมูลระบบจะตอบรับวาไดบันทึกขอมูลเปนที่เรียบรอยแลว พรอมที่
จะบันทึกขอมูลตอไป การเปลี่ยนรหัสผานก็ทําไดโดยกดที่เมนูเปลี่ยนรหัสผาน แลวจะปรากฏหนา
ตางดังรูปที่ 12 จากนั้นปอนรหัสเดิม และปอนรหัสใหมที่ตองการ เพื่อเปลี่ยนรหัสผาน จากนั้น
ระบบจะใหเขาสูระบบใหมอีกคร้ัง

ในการสืบคนขอมูลเปนสิทธิของเจาหนาที่ตํารวจระดับบริหารและผูจัดการระบบเทานั้นที่
จะสามารถใชงานในสวนนี้ได รูปแบบการทํางานทําไดโดยเลือก เมนู สืบคนขอมูลจากระบบ จะ
ปรากฏรูปดังรูปที่ 13 จากนั้นเลือกประเภทขอมูลที่ตองการสืบคน คือ ขอมูลคดีอาญาทั่วไป ขอมูล
คดีจราจร ขอมูลอาคารสถานที่  และขอมูลการแจงเหตุ หรือขอมูลการแจงเบาะแสจากประชาชน
เมื่อเลือกประเภทขอมูลเสร็จก็จะปรากฏรายละเอียดขอมูล ที่จะสืบคน ไปตามลําดับขั้น ในกรณีที่มี
ความตองการสืบคนในรายละเอียดปลีกยอยก็จะมียอยลงไปเรื่อยๆ ในกรณีเลือกปลีกยอย อ่ืนๆ ก็จะ
ปรากฏชองใหปอนคําสําคัญในการคน (Key Word) ลงไปเพื่อสืบคน
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กรณีตองการคนมากกวา 1 เงื่อนไข ก็สามารถระบุ และ หรือ เพื่อเชื่อมคําสําคัญในการสืบคน ซึ่งจะ
ไดขอมูลที่จงเจาะลงไปซึ่งเงื่อนไขที่ใหเชื่อมเงื่อนไขมี 5 เงื่อนไข อาจจะระบุแตกตางกันไปแลวแต
จุดประสงค ของผูทําการสืบคนขอมูลจากฐานขอมูล เมื่อเงื่อนไขขอมูลที่ทําการสืบคนพรอมก็กด
ปุม สืบคน เพื่อทําการคนขอมูลดังกลาว กรณีมีขอมูลก็จะปรากฏรายการขอมูลขึ้นมา พรอมกับ
ปรากฏ ขอมูลตําแหนงบนแผนที่ วาขอมูลที่สืบคนอยูตําแหนงใดของแผนที่ภูมิศาสตร นอกจากนี้
ผลที่ไดจาการสืบคน สามารถดูรายละเอียดของขอมูลดังกลาวได ซึ่งแสดงเปนรายงานในแตหัวขอๆ
เรียงกันไป กรณีมีการแสดงผลมากเกิน 10 รายการสืบคน ระบบก็จะแสดงผลทีละ 10 รายการเรียง
เปนหนาๆไปเร่ือยๆจนครบทุกรายการ

รูปท่ี 13 การสืบคนขอมูลจากฐานขอมูล
ในการสืบคนขอมูลในฐานขอมูลน้ันผูสืบคนสามารถที่จะ เลือกชั้นเลเยอรที่ตองการแสดงหรือไม
แสดงไดดวยตนเอง เพื่อความสะดวกในการมอง แตการสืบคนในหัวขอน้ันๆ ชั้นที่เกี่ยวของจะทํา
การเปดตัวเองโดยอัติโนมัติเพื่อแสดงรายการบนแผนที่ ซึ่งจะสัมพันธ กับผลการสืบคนที่ผูคนสืบ
คน
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ลักษณะการแสดงผลรายละเอียดหลังจากการสืบคนจะปรากฏดังรูปที่ 14

รูปท่ี 14 การรายงานรายละเอียดของคดีอาญาหลังผลการสืบคนขอมูล

ผลจากการรายงานรายละเอียด จะแสดงแผนที่และรายละเอียดของขอมูลน้ันๆ ที่ผูใชสืบคน สวน
แผนที่จะปรากฏสัดสวนของมาตราสวนอยูที่ 1:3000 รอบบริเวญจุดเกิดเหตุนั้นๆซึ่งสามารถนําไป
งานไดโดยเทียบมาตราสวนที่ถูกตองเขากับระบบแผนที่.
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กรณีผูใชที่เปนผูจัดการระบบจะปรากฏเมนูยอย จัดการผูใชในระบบ เพื่อทําการ เพิ่ม ลบ หรือ
ทําการแกไขเปลี่ยนแปลงขอมูล ของผูใชในระบบ จะมีลักษณะดังนี้

รูปท่ี 15 การจัดการผูใชในระบบ
ในการจัดการผูใชในระบบนั้น มี 3 สวนหลักคือ เพิ่ม แกไขขอมูล และ ลบรายชื่อ ออกจาก
ระบบ การเพิ่มรายชื่อทําไดโดยการปอนชื่อ เลือกระดับชั้นในการกําหนดสิทธิการใชงาน ปอน
รหัสผานจากนั้นปอนชื่อ สกุล ตําแหนง และรหัสประจําตัวของเจาหนาที่ตํารวจที่จะปอน เมื่อ
เสร็จก็ทําการ Submit เพื่อบันทึกขอมูล การแกไขขอมูลทําไดโดย เลือกเมนูแกไขขอมูล เลือก
รายชื่อในระบบที่ตองการแกไข จากนั้นเปลี่ยนระดับเพื่อเพิ่มหรือลดสิทธิการใชขอมูล แลวทํา
การเปลี่ยนแปลงขอมูลที่ตองการแกไข เชน ชื่อ รหัสผาน ชื่อ-นามสกุล จริง ตําแหนง รหัส
ประจําตัว เมื่อเสร็จทําการบันทึกโดยการกดปุม Submit ในการลบนั้นก็สามารถทําไดโดย เลือก
เมนูบันทึก และเลือกรายชื่อจากเมนูแลวทําการกดปุม Submit เพื่อลบรายชื่อนั้นๆ
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การใชงานหนาตางวิเคราะหแผนที่ เปนสวนที่เปดโอกาสใหผูใชงานระบบซึ่งมีสิทธิในสวนนี้ทํา
การปรับแตงแผนที่ เพื่อสรางโอกาสทางความคิดในแงมุมตางๆดวยตนเอง อันเปนหนทางในการ
ไดมุมมองความคิดใหมๆในการ จัดการทรัพยากร ใหมีประสิทธิภาพ ซึ่งมีรูปแบบดังนี้

รูปท่ี 16 รูปสวนวิเคราะหแผนท่ี
หนาตางแบบออกเปน 3 สวนหลักคือ สวนชั้นการแสดงผล สวนแผนที่ภูมิศาสตร สวนเมนู
สวนชั้นแสดงผล เปนสวนสํารับเปดปดชั้นที่ตองการหรือไมตองการดูขอมูลแผนที่ตางๆ

เพื่อเปนไปตามความตองการของผูใชแผนที่
สวนแสดงแผนที่ภูมิศาสตร ขอมูลจะเปลี่ยนแปลงไป ที่ผูใชงาน เลือก ยอ ขยาย หรือการ

คนหาขอมูลตางๆบนแผนที่ ซึ่งจะมีลักษณะเปน พลวัตร (Dynamics Map)
สวนเมนูตางๆ ประกอบดวย 3 สวนยอย คือ เคร่ืองมือทั่วไป อันไดแกการยอ การขยาย การ

เลื่อนแผนที่ภูมิศาสตร เปนตน สวนที่ 2 คือ สวนเคร่ืองมือพิเศษ ใชในการเลือกวัตถุบนแผนที่
ภูมิศาสตร การสรางบัพเฟอรจากวัตถุตางๆ และ การเลือกขยายตามวัตถุที่ถูกเลือก
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รูปที่ 17 การเลือกวัตถุในขอบเขตที่กําหนด (Select Within)
เลือกวัตถุที่ตองการจะเลือกวัตถุซึ่งอยูภายใตขอบเขต จากนั้นกดปุม Select Within เลือกประเภท
วัตถุที่ตองการจะเลือก

รูปท่ี 18 การขยายมาตราสวนโดยการระบุมาตราสวน
เลือกที่ เมนู Zoom Scale จากนั้นระบุตัวเลขที่ชอง New Scale ซึ่งมีหนวยเปนเมตรจากนั้นกดที่ปุม
OK ก็จะไดผลลัพธของแผนที่ภูมิศาสตรที่ตองการ

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d



117

รูปที่ 19 การขยายแผนที่ภูมิศาสตรตามวัตถุที่เลือก
การขยายแผนที่ภูมิศาสตรตามวัตถุที่เลือก กระทําไดโดยเลือกวัตถุที่ตองการขยาย แลวก็
เลือกปุม Zoom Selected เพื่อขยายวัตถุนั้นๆเต็มจอของบริเวณการแสดงแผนที่ภูมิศาสตร

ในการพิมพแผนที่ภูมิศาสตรกระทําไดโดย เลือกกดที่เมนู Print จากนั้นจะปรากฏหนาตางเพื่อให
เลือกรายละเอียดตางๆ ตามตองการวา ซึ่งประกอบดวยสวนตางๆดังนี้

Title คือ สวนชื่อแผนที่ภูมิศาสตรที่ตองการพิมพ
Legend คือ สวนรายละเอียดบนแผนที่
Scale bar คือ มาตราสวนที่จะระบุบนแผนที่
North Arrow คือ สัญลักษณเพื่อบอกทิศเหนือของแผนที่
URL คือ ชื่อเวบไซตหรือที่อยูของแผนที่วาอยูที่ใด
Date/Time คือ วัน/เวลาปจจุบันขณะที่ทําการพิมพ
Map Site คือสวนที่ใหระบุมาตราสวนเองหรือใหเลือก แบบอัตโนมัติซึ่งจะพิมพเต็มแผน
กระดาษ และทายสุดเปนสวนเซ็ตคาของเครื่องพิมพ ซึ่งแตกตางกันออกไป
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รูปที่ 20 การพิมพแผนที่

รูปที่ 21 การทําบัพเฟอร
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การทําบัพเฟอร นั้นกระทําไดโดยเลือกวัตถุที่ตองการจะทําบัพเฟอร จากนั้นเลือกเมนู Buffer
จะปรากฏหนาตางดังรูปที่ 30 จากนั้นระบุคุณสมบัติของบัพเฟอรที่ตองการ ดังนี้

Buffer Offset Distance คือระยะหางจากวัตถุที่เลือกจะกําหนดใหมีคาเทาใดพรอมหนวยวัด
Create buffer on คือใหระบุชื่อชั้นที่ตองการสรางบัพเฟอร (Buffer Layer)
Construct One Buffer for all Selected map feature เปนการเลือกเมื่อตองการเชื่อมบัฟเฟอร
กรณีเลือกเลือกวัตถุที่ มีขอบเขตของบัพเฟอรติดกันและเปนบัฟเฟอรเดียวกัน
Fill & Edge เปนการระบุคุณสมบัติของบัพเฟอรที่ตองการวาตองการ ใหมีคุณสมบัติอยาง
ไรบาง เชน เสน สี ระบายทึบ หรือมีรูปแบบที่เปน ลวดลายตางๆ ตามที่ระบุ

รูปที่ 22 การวัดระยะทาง
การวัดระยะทางกระทําไดโดยเลือกเมนู Measure จากนั้นก็ระบุตําแหนงบนแผนที่ กรณี
การระบุตําแหนงมากกวา 1 จุดขอมูลความยาวของระยะทางก็จะรวมใหโดยสังเกตุไดจาก
กลองแสดงระยะทางปรากฏในรูป ซึ่งระยะทางที่ปรากฏหมายถึงระยะทางของตําแหนง
ปจจุบันยอนหลังไป 1 ตําแหนงแตระยะทางรวมจะนับรวมตั้งแตจุดเร่ิมตน
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รูปท่ี 23 การเพิ่มเติมขอมูลบนแผนที่
การเพิ่มเติมขอมูลบนแผนที่เปนการเพิ่มเติมขอมูลในลักษณะเฉพาะบุคคลซึ่งเปนคนละสวนกับขอ
มูลหลัก เพื่อบันทึกขอมูลอันเปนประโยชน หรือชวยในการจัดการของแตละเฉพาะบุคคล เชนการ
เพิ่ม เสน รูปปด วงกลม ตัวอักษรตางๆ รวมทั้งสัญลักษณ ทั้งนี้สามารถกําหนดรูปแบบตางๆไดตาม
ตองการ
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ภาคผนวก ช
(ตัวอยางแบบสอบถาม)

แบบสอบถาม
ระบบสารสนเทศภูมิศาสตรเพ่ือการแจงความและสถิติอาชญากรรม

ของตํารวจภูธรเชียงใหม

คําชี้แจง
1. แบบสอบถามมีวัตถุประสงคเพื่อตองการทราบผลการใชงานเพื่อการแจงความและสถิติ

อาชญากรรม ของตํารวจภูธรเชียงใหม และเพื่อเปนขอมูลในการปรับปรุงและพัฒนาใหมีประ
สิทธิภาพตอไป

2. ความคิดเห็นที่ทานตอบนี้มีคุณประโยชนเปนอยางยิ่ง และคําตอบของทานจะไมสงผลกรทบ
ตอผูตอบแบบสอบถามใดๆ ทั้งสิ้น

แบบสอบถามมีทั้งหมด 3 ตอน คือ
ตอนที่ 1 ขอมูลของผูตอบแบบสอบถาม
ตอนที่ 2 ประสิทธิภาพของการใชงานระบบ
ตอนที่ 3 ขอเสนอแนะและแนวทางในการปรับปรุงและพัฒนาระบบ

      ตอนที่ 1 ขอมูลผูตอบแบบสอบถาม ลงใน
         โปรดทําเครื่องหมาย    �  ลงใน   �  หนาขอความที่ตรงกับความเปนจริง

         �  เจาหนาที่ตํารวจผูรายงานคดี ประจําสถานีตํารวจ
         �  เจาหนาที่ตํารวจหัวหนาสถานีตํารวจ
         �  เจาหนาที่ตํารวจระดับบริหารประจําภูธรจังหวัดเชียงใหม
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ตอนที่ 2 ประสิทธิภาพของการใชงานระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติ
               อาชญากรรมของตํารวจภูธรเชียงใหม

   โปรดทําเครื่องหมาย    �  ลงใน ชองที่ทานเห็นวาเปนจริงมากที่สุด

ลักษณะการใชงานระบบสารสนเทศภูมิศาสตรเพ่ือการ
แจงความและสถิติอาชญากรรม

ของตํารวจภูธรชียงใหมในดานตางๆ มา
กท

ี่สุด

มา
ก

ปา
นก

ลา
ง

นอ
ย

นอ
ยท

ี่สุด

1. ความสะดวกตอการใชงาน
2. หนาตางการใชงานระบบเขาใจงายไมซับซอน
3. ความเหมาะสมของการจัดวางเมนู การใชงานบนจอภาพ
4. ความถูกตองของขอมูลหลังจากการสืบคน
5. ความสมบูรณของรายงาน
6. มีระบบการรักษาความปลอดภัยที่ดี
7. การสืบคนขอมูลทําไดงายและสะดวก
8. คูมือการใชงานระบบ มีความชัดเจนตอการใชงาน
9. ชวยลดขั้นตอนการทํางานปจจุบัน
10. สามารถนําระบบไปประยุกตใชงานไดจริง

ตอนที่ 2 ขอเสนอแนะและแนวทางการปรับปรุงและพัฒนาระบบสารสนเทศภูมิศาสตรเพื่อการ
               แจงความและสถิติอาชญากรรมของตํารวจภูธรเชียงใหม
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………..

ขอขอบพระคุณที่ใหความรวมมือในการตอบแบบสอบถาม
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ภาคผนวก ซ
รูปแบบ รายงานคดีอาญาท่ัวไป แบบเดิม
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รูปแบบ รายงานคดีจราจร แบบเดิม
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ประวัติผูเขียน

ชื่อ-สกุล นาย ประสงค ปาณศรี

วัน เดือน ปเกิด 18 ธันวาคม 2510

ประวัติการศึกษา สําเร็จการศึกษาปริญญาตรีครุศาสตรบัณฑิต
สาขาวิชาการศึกษา สถาบันราชภัฎเชียงใหม
ปการศึกษา 2538

ประสบการณ อาจารยพิเศษ คณะสถาปตยกรรม มหาวิทยาลัยเชียงใหม
สอนคอมพิวเตอรเพื่อการออกแบบ (Computer Aided Design)

ตําแหนง Network Operation Center Manager
บริษัท เชียงใหม อินเทอรเน็ต จํากัด
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